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What is Press-Ready?

A cover which requires no addition-
al typesetting or alterations and is a
digital file is considered press-ready.
The cover is ready to plate and print.
The quality of the printed piece
depends on the quality of the press-
ready material which is provided.

Read through this entire guide, care-
fully following the instructions for
submitting a press-ready cover. Be
sure to use the correct template
based on the chosen cover style.
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Press-Ready Options

There is only one press-ready option available:

A digital file, created on a Macintosh® or PC platform, with no manipulation
required, ready to be output to plate. Send a printout of your final cover that
matches your digital file. This will only be used to verify content, not color.
Home office color printers and monitors are not reliable for color accuracy
since they are not calibrated to our printing equipment.

Materials not press-ready are: black/white lasers, color printouts, paper
plates, or paste-ups. If this material is submitted, the cover will be recreated as
closely as possible.

Note: If you cannot provide a press-ready digital file, but have specific ideas or
artwork you want to use, we can help. Download the Cover Information Sheet
from our web site’s download center and follow the instructions.

Proofs

A free proof will be created for approval when a press-ready cover is submitted.
A black/white laser proof will be sent on a cover using only one color. A color
proof will be sent on a cover with two or more colors. Production will continue
when the proof has been approved.



Submitting a Digital Press-Ready Cover

Accepted Software & Material

Digital files will be accepted if they are created on a Macintosh® or

PC platform using only the following software.

¢ QuarkXPress® 3.3 or newer

* Adobe Photoshop™4.0 or newer

* Macromedia® Freehand™ 8.0 or newer

* Adobe Illustrator™5.5 or newer

e Burn files onto a CD or DVD, and label it with the organization
name, book title, and type of file (Quark®, Photoshop™, etc.).

Submit a current hard copy of the cover with the CD or DVD. This
can be a black/white printout or copy with colors clearly labeled if it
is a spot color cover. A color copy is not necessary since a color proof
will be created.

Using Art and Type in QuarkXPress®

* Photos and artwork should be scanned and saved at the size they
will be used in QuarkXPress®, not scaled in the Measurements
palette. Picture box specifications should show all artwork at 100%.

* Do not rotate or flip artwork in QuarkXPress®, but rather in the
graphic software it was created in, like Photoshop™.

* Do not apply a “style” to type in the Measurements palette of
QuarkXPress®. Select the actual typestyle from the font menu.
Check Font Usage (if using QuarkXPress®) to ensure all fonts are
being used in this manner.

Digital Files to Include

* All linking art files (i.e., EPS or TIFF files) of the images placed in
the document. Check Picture Usage in QuarkXPress® to ensure no
images are missing. Place artwork in a folder named Cover Art.
Do NOT use any compression methods on files.

* Both the screen font suitcases and printer fonts for all fonts used on
the cover. Do NOT use Truetype fonts - they do not work with com-
mercial printing systems. If fonts are substituted, type could reflow,
causing leading and kerning problems. Place fonts in a Fonts
Folder. See page 10 for details.

* Any fonts in art files must be converted to an outline in the appli-
cation in which they were created, or these fonts must be furnished
in the Fonts Folder; otherwise, they will not print correctly.

* Any program extensions or plug-ins that are not included in basic
software packages which have been used to create the document
(especially QuarkXPress® extensions).
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Design Considerations for Digital Files

Using Artwork and Photos

* Full-color scans or Photoshop™ files should be saved as EPS files at 300 dpi. Photoshop™ files at
72 dpi are not acceptable quality. Artwork downloaded from a web site and some stock photogra-
phy are usually created at 72 dpi.

 All full-color artwork and photos should be saved as CMYK files. RGB files will not be
accepted.

* Images must be scanned and saved at the size they will be used or larger. If an image bleeds off
the cover, allow additional image on the side(s) that bleeds. See templates for required bleed area
(p. 5-9).

* Line art images should be saved as TIFF files and scanned at 600 dpi.

* Lines, including those contained within art, should have a minimum rule line weight of .5 points.

Scanning Photos (grayscale only)
* Scan color or black and white photos, to be printed in black and white, at the size they will be
used in QuarkXPress®. Use the following settings when scanning:

1. black and white photo (grayscale).

2. resolution 300 dpi.

3. de-screen when necessary.

* Adjust scans in Photoshop™ using these steps.

1. Crop and retouch photos as needed.

2. Open Image/Adjust/Levels. Move the endpoint for darks to 95% output. Move the endpoint
for lights to 3% output. Adjust midtones to 20% - 30%. Photos should look slightly lighter
than expected.

» Save grayscale photos as TIFF or EPS files.

Using Black

When a large area of solid black ink overprints across different colors, there will be a noticeable
change in the density of black between the areas. Eliminate this by creating a process black formu-
la with Cyan 65%, Magenta 53%, Yellow 51%, and Black 100%. This will eliminate any density
variations in the black. Use this formula for large black areas on full-color covers.

Smaller black areas such as lines, type, or artwork with black strokes should be made of 100% black
and set to overprint.

Trapping
A trap is an extra amount of one ink, printed over another ink, to ensure the white of the paper will
not show through where colors meet if registration is slightly off.

If the cover is comprised of two or three spot colors and the colors touch, they must be trapped.
Generally, process colors don’t need to be trapped. There are some exceptions. A spot color, such
as a metallic color or a Pantone color, should be trapped. Consult the manual of the software being
used for more information on trapping.

When trapping in QuarkXPress®, enter an amount of 0.15 point in the trapping preferences for what
you are choking or spreading. Make sure “Process Trap” is not checked. When trapping in Adobe
Iustrator™, choking or spreading is controlled by the stroke on an object. Double the line weight
recommended for the trap; this is necessary because Adobe Illustrator™ strokes both sides of a line
equally. To ensure a trap of 0.15 point, give the object a stroke of 0.3 point and set the stroke to over-
print; do not overprint the fill. If an imported image is reduced in QuarkXPress®, the trap will also

be reduced.

There are times when text or an object is too small to trap. Consider overprinting the text or object,
but keep in mind that overprinting one color on top of another can alter the overprinted color.

Trapping is a complex issue that cannot be fully addressed in this guide. Consult a QuarkXPress®,
Adobe Illustrator™, or PhotoShop™ manual for more information on trapping.
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Cont... Design Considerations for Digital Files

Copyrighted Materials

DO NOT submit artwork or photos without a written, signed release from the
copyright owner giving permission for their use. Generally, all artwork and
photos are copyrighted, unless you are using royalty-free photos or clip art,
you own the images, or you paid someone to create artwork for your book.
Examples of copyrighted images may include photos from a newspaper to
printed materials such as greeting cards and books. Download our Art
Release Form from our web site’s download center. Complete and sign it;
submit the form with your cover material.

Photos Taken with a Digital Camera

With recent advances in digital cameras, it is possible to take photos that are
of acceptable quality for offset printing. There are three basic factors that will
determine if images produced by your camera are suitable for printing: com-
pression, resolution, and file format.

Compression affects image quality and destroys image data. Compressed pho-
tos are NOT suitable for printing. If your camera supports uncompressed
image data such as TIFF or RAW, you should use those settings. If these are
not available, use the lowest possible JPEG compression ratio setting.

Resolution determines the overall quality of your digital photos. Resolution
is expressed in megapixels or pixels in height and width. Do not rely on
megapixels since this number does not necessarily provide a true image size.
Your camera’s manual should list how many pixels, in height by width, it is
capable of taking at full resolution. To find the maximum print size, divide
by 300 for each axis. The result is the maximum dimension (in inches) that
the photo can safely be printed. For example, a camera with full resolution at
2048 x 1536 pixels would result in a 6.826 x 5.12 inches maximum print size
(each axis divided by 300).

After transferring your photo to your computer, do NOT resize the image,
alter its resolution, or save for web output. Save the image in TIFF or EPS
format, which are the standard file formats for printing.

Your uncompressed image files will be several megabytes in size, so they will
need to be copied onto a CD or DVD. If your files fit on a 3.5" floppy
diskette, they most likely are compressed and unsuitable for printing.

1536 pixel

~———— 2048 pixels ————

Maximum Print Size
1536 ppi h/300 = 5.12"
2048 ppi w/300 = 6.826"
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Cover Template - Soft Cover
with Plastic Comb or Coil Binding

Templates 1 and 1b

e Document Width = 5 12" (5.5).

e Document Height = 8 12" (8.5).

* Front cover margins are 3/8" (.375) for the top, bottom, and
right side, and !1/16" (.6875) for the left side. Template 1.

* Back cover margins are 3/8" (.375) for the top, bottom, and
left side, and /16" (.6875) for the right side. Template 1b.

* The wider margin of /16" is needed for the plastic comb
binding punch.

* The white areas on Templates 1 and 1b are the image
areas. Do not extend type or artwork beyond these areas
unless it is intended to bleed. Center text and artwork
within the image areas, not the document edges.

3g"

e If color or artwork bleeds, extend it into the margin areas
(light gray area) and /8" (.125) beyond the edge of the
document on all four sides (darker gray area). The /8"

bleed area will be trimmed off.

 The finished book size is 5 12" x 8 1/2".

Note: A printed back cover is optional and will incur an
additional charge. Back covers will be white unless you
order a printed back cover. See our Cookbook Publishing
Guide for pricing and details.
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Cover Template - Hardback
with Plastic Comb Binding

Templates 2 and 2b

e Document Width = 7 12" (7.5).

* Document Height = 10 /4" (10.25).

¢ Within the document, make 3/4" (.75) bleeds on all sides of
the front and back covers. Note that the bleed area is with-
in the document. This area is needed even if the cover does
not bleed. It will wrap around the hardback board and par-
tially appear on the inside cover.

* From the 3/4" bleeds, set front cover margins that are 3/8"
(.375) for the top, bottom, and right side, and !1/16" (.6875)
for the left side. Template 2.

* From the 3/4" bleeds, set back cover margins that are 3/3"
(.375) for the top, bottom, and left side, and !1/16" (.6875)
for the right side. Template 2b.

* The wider margin of /16" is needed for the plastic comb
binding punch.

* The white areas on Templates 2 and 2b are the image
areas. Do not extend type or artwork beyond these areas
unless it is intended to bleed. Center text and artwork
within the image areas, not the document edges.

* If color or artwork bleeds, it must extend into the margin
areas and also fill the 3/4" bleed areas (light gray and dark
gray area). If it does not bleed, leave both areas white.

* The finished book size is 6" x 8 3/4".

Note: A printed back cover is optional and will incur an
additional charge. Back covers will be white unless you
order a printed back cover. See our Cookbook Publishing
Guide for pricing and details.
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Hardback Liner - Templates 3 & 4

Standard liners for hardback books are white or cream (not

printed). One-color, multi-color, and full-color printed liners

are available for an extra charge. Follow the guidelines below.

o If liners do not bleed, make the document 11 /4" x 8 3/8"
(11.25 x 8.375). See Template 3.

e If color or artwork bleeds, make the document 11 1/2" x 8 3/3"
(11.5 x 8.375). See Template 4. The extra /4" is for the
gutter between the front and back liners.

* On both Templates 3 and 4, set image areas for the front
and back liners with margins 3/8" (.375) from the top, bot-
tom, and outside edge, and !!/16" (.6875) from the inside
edge. The extra space for the inside edge is needed for the
plastic comb binding punch.

* The white areas on Templates 3 and 4 are the image areas.
Do not extend type or artwork beyond these areas unless it
is intended to bleed. Center text and artwork within the
image areas, not the document edges.

o If color or artwork bleeds (especially patterns), extend it
into the margin areas and !/8" (.125) beyond the edge of
the document on all four sides. The /3" bleed area will be
trimmed off. (Template 4 only)

* If color or artwork bleeds on the inside edge, extend it /8"
(.125) into the !/4" gutter between the front and back lin-
ers. This bleed will be trimmed off. (Template 4 only)

* The finished size for each liner is 5 5/8" x 8 3/3".

Note: We do not recommend custom
liners with solid color or dense coverage
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Cover Template - 3-Ring Binder (1" Ring)

Template 5

* Document Width = 17". The front and back covers will
each measure 7 5/8" (7.625) wide and there is a 1 3/4"
(1.75) spine between them.

* Document Height = 10 3/4" (10.75).

e Within the document, make 3/4" (.75) bleeds on all sides of
the document. Note that the bleed area is within the docu-
ment. This area is needed even if the cover does not bleed.
It will wrap around the board and partially appear on the
inside cover.

* From the 3/4" bleed areas, set margins for both the front
and back covers that are 3/8" (.375) from the top, bottom,
outside edge, and inside edge of the spine.

e If color or artwork bleeds, extend it into the margin areas
and also fill the 3/4" bleed area (light gray and dark gray
areas). If it does not bleed, leave both areas white.

17"

* The white areas on Template S are the image areas. Do
not extend type or artwork beyond these areas unless it is
intended to bleed. Center text and artwork within the
image areas.

* For spine printing, keep wording centered in the white
spine margin area shown (7 1/8" tall x 1” wide). If you
exceed this area, wording will get too close to the fold
or into the rivets of the 3-Ring. Do NOT use the entire
1 3/4" area for wording as the fold is in this area. Face
spine wording in the direction shown.

o If the book exceeds 326 pages, a 1 12" ring will be
required. Call for more details.

* The finished book size is 6 7/8" x 9 1/4".

Note: Custom front cover ink charges include front cover
and spine printing. A printed back cover is optional and
will incur an additional charge. Back covers will be white
unless you order a printed back cover. See our Cookbook
Publishing Guide for pricing and details.

Spine 1 3/4"

Back Cover
Image Area

Type and artwork not
intended to bleed
must stay in white area.

10 34"

Template 5
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on all sides
Front Cover of each cover
Image Area
Type and artwork not
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margin area
dark gray =
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If color or artwork
bleeds, it must fill the 3/s"
bleed area on all sides.
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3-Ring Liner

Template 6

Standard liners for 3-Ring books are white or cream (not

printed). One-color, multi-color, and full-color printed liners

are available for an extra charge. Follow the guidelines below.

* Document Width = 15". The front and back liner areas
each measure 6 916" (6.5625) and there is a 1 7/3" (1.875)

spine area.

* Document Height = 8 3/4" (8.75).
* Set image areas for the front and back liners with margins
3/8" (.375) from the top, bottom, outside edge, and edge of

the spine.

Key

white =
image area

light gray =
margin area

&

dark gray =
bleed area

8 34"

* The white areas on Template 6 are the image areas. Do not
extend type or artwork beyond these areas unless it is
intended to bleed. Center text and artwork within the
image areas, not the document edges.

e If color or artwork bleeds (especially patterns), extend it

into the margin areas (including spine area) and /8" (.125)

beyond the edge of the document on all four sides (into the
dark gray area). The 1/8" bleed area will be trimmed off.
* The finished liner size is 15" x 8 3/4".

Note: We do not recommend custom liners with solid
color or dense coverage of ink. This can result in unwant-
ed ink transfer, rubbing onto adjacent pages.
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Collecting & Submitting Fonts

If you submit your pages or cover as digital files, fonts will also need to be submitted. Follow these instructions to col-
lect fonts. These instructions assume that font management solutions such as Extensis® Suitcase™ are not being used. If
font management software is in use, please consult your user documentation for more information on collecting fonts.

Sending Fonts When Using Windows XP, 2000, 98, and Windows Me:

For Windows XP:

1. Click the Start menu and select Control Panel. The Control Panel window appears.

2. What you see is the Windows XP Control Panel Category view. In order to send the necessary fonts, change the view
to Classic mode. In the upper left corner of the window, click the option labeled Switch to Classic View.

3. On the right side of the Control Panel window, double-click the item labeled Fonts. A list of fonts on your computer
appears.

4. Locate the fonts needed for your project and select them by holding down the Control key on the keyboard and click-
ing each font once.

5. Click the Edit menu at the top of the window and choose Copy.

6. Close the Control Panel window and all other windows.

7. On the Windows Desktop, click once using the right mouse button. Point to the option labeled New and click Folder.
Type a new name of “Fonts Folder” and press the enter key.

8. Double-click this new folder. Click the Edit menu and choose Paste. When you send us your work, be sure to include
this folder of fonts along with your job.

For Windows 98, Me, and 2000:

The process of sending fonts using Windows 2000, 98, or Me is virtually identical to Windows XP except for the follow-
ing two exceptions:

1. To bring up Control Panels, click Start, point to Settings, and click Control Panel.

2. Windows 2000, 98, and Me do not require switching control panels to classic view.

Sending Fonts When Using Mac OS 9 or OS X:

For Mac OS 9:

1. Close all open windows on the screen (desktop). From the menu at the top of your screen, choose New Folder from
the File menu. An “untitled folder” appears on your desktop.

2. Type a new name of “Fonts Folder” and double-click this new folder to open it.

3. Double-click your hard drive’s icon.

4. Double-click the System Folder, and then double-click the Fonts folder.

5. Locate the fonts needed for your project and copy them one by one to the “Fonts Folder” folder. This is done by hold-
ing down the Option (Alt) key while dragging each font to the “Fonts Folder” folder. When you send us your work, be
sure to include this folder along with your job.

For Mac OS X:

1. Mac OS X keeps fonts in three standard locations: 1) /System/Library/Fonts 2) /Library/Fonts, and
3) /Users/<your home folder>/Library/Fonts
In addition, the system also stores fonts in the Mac OS 9 “Classic” System Folder described above. Note: This is only
if you have the Mac OS 9 Classic environment installed on your Mac OS X system.
2. Locate the folder(s) that contains your fonts. Select multiple fonts by holding the Command (or Apple) key and click-
ing each font once.
. At the top of the screen, click the Edit menu and choose Copy. Close or minimize all windows on the screen.
. Hold down the Control key and click once on the Desktop.
On the menu that pops up, click the item labeled New Folder.
. Type a new name for this folder such as “Fonts Folder.”
. Double-click this new folder. At the top of the screen, click the Edit menu and choose Paste. When you send us your
work, be sure to include this folder along with your job.
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